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ABSTRACT 

This research develops a general purpose controlling program, named 

FEM2D, which can be used for to two-dimensional static and dynamic finite 

element analysis and a general purpose post-processing program POST2D. The 

post-processor makes use of technologies of Interactive, Menu-Driven, Multi-

windows, On-line Help, and Object-Oriented program. It can be employed to deal 

with the results of finite elements and to display the results in the forms of Mesh, 

Vector Arrow, contour Line and Color Contour with computer graphics. Due to 

the improved linear interpolation and the refined method of area comparison search, 

the speed of graphic process is increased significantly. 

Static and dynamic linear as well as non-linear analyses of a concrete dam 

on rock foundation are performed using the SST DYN finite element program. 

Results from the use of the POST2D program are used to analyze stresses and 

deformations under static and dynamic (earthquake) loading, including comparison 

of results from linear and nonlinear constitutive research. 
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Chapter I. Introduction 

1.1 General 

Nowadays, it has become possible to perform stress-deformation analysis of 

engineering structures, on a scope never before possible, by using the personal 

computer. However as the volume of input and output data increases, a problem 

arises. As to how can interpret these data efficiently and effectively, and transfer 

them between the computer and the user? The computer can easily generate tables 

of numbers hundreds of page long, but such a printout may be of limited use unless 

the analyst can interpret and use it effectively. Because of the large amount of data 

needed for the Finite Element Method (FEM), and the large set of solution values 

obtained, the data preparation and output retrieval sections of the Finite Element 

Method program have gained tremendous importance. These programs are known 

as Pre processors and Post processors. 

Output from the finite element program contains a large volume of 

information in a form which is probably not suitable for the illustrative presentation 

of the results. In the computing world, computer graphics is generally recognized 

as the most effective and versatile communication medium between the user and 

computer. By using computer graphics, a general purpose post-processor program 

can reduce the time and cost for processing of results, and to eliminate human 

errors during the result interpretation. A purpose of this research is to develop such 

a post processor. 
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1.2 Survey of Literature 

The finite element method has become one of most important practical 

method in computational mechanics. FEM has been widely used in almost every 

field of engineering and applied science. Thousands papers and research reports are 

published each year. It is impossible to review all of these publications. The author 

will limit his attention to the articles closely related to the research and provide 

brief discussion. It is not easy to give a detailed description of theoretical 

foundations of FEM; such details are available elsewhere, ex. Desai[l]. 

With increasing applications of the FEM, Pre- and Post-Processors become 

more and more important. Pre- and Post-Processor even can decide the success of a 

FEM program. Mackerle[4] reviewed several popular programs in the market. He 

pointed out that every FEM program has a relative strength or weakness when used 

for analysis of a certain problem. To select a program depends on the field for 

which the program will be used, hardware available and the kind of problem. 

Meek and Bandyopadlhyay[5] described Pre- and Post-Processors used in 

the FEM and their application in geomechanics. Their Pre-Processor contains 

program which plots structure models and element mesh. This will make engineer's 

modeling process displayable and make the errors to be detected easier. The post

processing program plots displacement and stress contours in a plane. They used the 

interpolation method that combines the quadratic and linear interpolations. 
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FEPRE2D[6] is a Pre-Processing program written in Turbo Pascal language. 

Modified FEPRE2D is used as an independent module which has been combined to 

the FEM2D package. It is also used in the Post-Processing of geometric menu 

system. 

Akin[8] describes the isoparametric element and coordinates transformation. 

In his program Akin did not use common linear interpolation method, instead he 

used an interpolation procedure, which is based upon isoparametric interpolation 

function itself, for contouring on any isoparametric finite element surface. 

FEPOST2D[9] is a relative simple Post-Processor. Most of its functions 

depend on another two software package, Graphical Kernel System and Computer 

Graphical Interface. Because these two packages need much memory and have a 

strike requirement for hardware, FEPOST2D's application is limited. 

1.3 Scope and Objectives 

The goal of this project is to produce a general purpose master control 

program FEM2D and a finite element post-processor POST2D. The term 'general 

purpose' means processing that is applicable to many types of problems. 

The post-processor program reads information from a post-processor data 

file (extension .PST) and then allow the user to display it in the form of engineering 

graphs. Generally the data file is produced automatically from a Finite Element 
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program, such as SST DYN[3], and any data file that conforms to the post

processor standard can be read and displayed. 

As a large program, FEM2D should possess the following two of the most 

important attributes: 

* The program should be modular. 

* The interface between modules should be understandable and easily 

specified. 

Since Object-Oriented programming satisfies both of these requirements, 

FEM2D is written using Turbo Pascal and Object-Oriented language Turbo Vision. 

The master control program of FEM2D and POST2D are designed to meet 

the needs of several finite element programs. The functions of FEM2D and 

POST2D include: 

- gather and manipulate information, 

- multi-file editor, 

- graphic display with zoom function, 

- print and plot function, 

- mouse support, menus and dialogs, 

- multiple overlapping windows, and 

- enhanced hypertext on-line help facilities. 
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Chapter II. Object Oriented Programming 

The conventional programming languages, such as Pascal, FORTRAN, 

COBOL, and C can be thought of as a supporting procedure-data model of 

computation. They draw a distinction between the data being manipulated and the 

procedures that actually perform the manipulation. Procedures and data are written 

as separate entities. Procedures are active agents operating on passive data 

elements. Programming is accomplished by constructing functionally specific 

program models and invoking them through procedure calls. Procedures then 

operate on the data. 

Object Oriented Programming(OOP)[12] is a technique in which one can 

directly represent entities as a hierarchy of objects and information exchange as a 

set of methods. OOP balances control and structures and consequently yields a 

more natural model of the problem intended to be solved. The fundamental 

building block of OOP is the object. The object is a single bundle which combines 

information and any operations that can be performed on that information. In OOP 

lingo, this bundling is termed encapsulation; the operations are methods. With 

object oriented programming, computation is achieved by passing messages to (or 

making requests of) the objects in a program. Object responds to messages by 

producing new objects as results. Each object can be thought of as a small virtual 

processor whose behavior is defined solely by how it responds to receiving a 

message. The important thing is that the message doesn't have to tell the object 

how to do something, only to do it. 
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Most of the programmers are used to defining data structures to hold 

information and to define procedures and functions that manipulate information. In 

OOP, data and procedures are combined into objects. An object contains both the 

characteristics of an entity (its data) and its behavior (its procedures). By welding 

these characteristics and behaviors, an object knows everything it needs to do its 

work. 

The objects make programs more accurately conform to the way we deal 

with the real world. To gain this quality, objects depend on three main 

properties: 

1. Encapsulation 

The welding of the code and data together into objects is called 

encapsulation. One of the rules of encapsulation is that the programmer need never 

directly access the data fields within an object. Instead, any operation should be 

defined within the object to handle all data manipulation. The primary benefit of 

encapsulation is that by limiting access to just the operations. Suppose we are 

forced to change the name fields. If we have used encapsulation properly, we can 

make the change without affecting other code. 

2. Inheritance 

Although objects contain data and methods of their own, they can also 

inherit both from other objects. In the OOP, the inheritance concept can be used to 

build increasingly complex objects. 
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Not only do objects inherit data, they also inherit methods. The method 

names can be duplicated for inherited objects, data field names cannot. Once an 

object's data field is named, no data field in any descendant object can share that 

field's name. That means we cannot override data fields as we can methods. 

3. Polymorphism 

Giving an action one name that is shared up and down an object hierarchy, 

with each object in the hierarchy implementing the action in a way appropriate, to 

itself. 

In the OOP, the item can be treated polymorphically. That means we can do 

more than just store an object type on a collection which is an object that stores a 

collection of pointers and provides a host of methods for manipulating them. We 

can store many different objects' types from anywhere in our object hierarchy. 

The goals of object oriented programming are: to simplify the generation of 

large, complex software systems, and to encourage the production of software that 

is modular, easily understood, reusable, and adaptable to change. This procedure is 

used to create the master control program FEM2D. 
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Chapter III. Finite Element Method and Post-Processing 

3.1 Finite Element Method 

In analytic on classical mechanics, what is needed is to find the solution of the 

practical differential equation so as to describe the properties of an elastic body. This 

kind of solution is a mathematical expression. It gives the unknown that is requested 

at each point in the body. However in many engineering problems, it is difficult to 

obtain the analytical solution because of factors such as irregular geometries, 

nonhomogeneities, and nonlinears behavior. 

The essence of finite element method is to idealize a continuum that has infinite 

degree-of-freedom to a set of elements with only finite degree-of-freedom. This 

procedure simplifies the problem significantly and if the stiffness properties of the 

elements are determined, the problem reduces to solution of a set of algebraic 

simultaneous equations. 

Finite element method starts with the study of stiffness properties of finite 

elements, and finally obtains a set of algebraic simultaneous equations in which the 

nodal displacements are the unknowns. Solution for the nodal displacement needs to 

evaluate of other design quantities such as strains and stress. However, very often the 

an input and export data can be very large. The software which is used to analyze and 

prepare the data for the finite element method is called pre-processors, while those 

used to display the results by means of computer graphics are called post-processors. 
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3.2 Post Processor 

Engineering analysis is undergoing rapid change with the advent of 

computer graphics. Computer graphics permit rapid construction of finite element 

models. They also permit automatic static and dynamic structural analysis of 

mechanical parts subjected to a variety of loading conditions. With new graphics 

capabilities, the effects of these loads can be displayed. Analytical results presented 

graphically can provide clearer and easier interpretation toward analysis and design. 

This research is concerned with the Finite Element Analysis. Figure 3.1 

shows a flow diagram of the Finite Element Method. The whole process, which 

includes pre-processing and post-processing, will be referred to as the interactive 

computer graphics analysis process. 

An important use of graphics is in the post-processing of finite element 

results. The Post-Processor can include vectors and contours of displacement or 

stresses in desired zones of interest so that the analyst can have an overview of the 

results as a whole, and understand the implications of the analysis rather than 

having to sift through pages of computed results. Specially contours can be 

displayed by using color graphics to further enhance the different contouring levels. 

Various algorithms have been proposed by previous researchers for contouring two-

dimensional plots of an object. 
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Figure 3.1 FEM analysis process 

3.3 Contour Line 

When a continuum is divided into a set of finite elements, the stresses on 

every point of this structure will be changed into discrete points in the continuum. 

The characteristics of the original model, for example, shape, deform, stresses and 

strains, etc., can be studied at these discrete points. Contour line is a graphical 

method to illustrate the actual value in a defined area by connecting all the points 

that have equal values of a given quantity. In the computer graphics, contour line 

must satisfy the following requirements: 

1). A contour line is a continuous curve, 
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2). For given a definite contour value, the contour lines will not be 

limited to only one in a corresponding area, 

3). As to the bounds of the region, contour line can be a close loop curve 

or connected with the outer area, and 

4). Contour lines do not cross each other. 

To draw a contour line, generally, there are two steps: first is to transfer a 

series of discrete points into a regular grid, and the second is to link all the grid 

points that have the same value in the defined area to contour lines. 

In the finite element method, the conception of isoparametric elements can 

be easily used to mesh the value at the discrete nodes. The local coordinates, such 

as r and s, are usually dimensionless and range from 0 to 1, or from -1 to 1, 

Figure 3.2. 

By the way of coordinate transformation, a regular square grid can be 

acquired. The next step is to calculate the coordinate of the intersection point at 

which the given value crosses each grid line, and then to connect these intersection 

points. The general method is to find a stating point of the contour line, and then 

to work out the intersection points one after another along the contour line. At the 

same time, the connective sequence can also be obtained. The precision of drawing 

a contour line depends on the spacing between the grids that are chosen. If the 

space is too small, the amount of calculation will be large, while too large a spacing 

can result in errors. If the regular grids are chosen small enough, it is easy to 

connect the intersection points with straight lines and adopt them as contour lines 
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instead of adopting a certain kind simulating algorithm to link these points 

smoothly. There are several kinds of different graphical methods described for 

contouring which are briefly discussed as following: 

( a )  G l o b a l  

5 

5 5 

( b )  L o c a l  

Figure 3.2 An isoparametric element formulated in local coordinate system 

1. Whole-region searching method. 

The outer bounds of the region are first found and then check the 

intersection points on the boundaries. If the point can be found, it will be taken as 

a starting point, otherwise, to retrieve intersection points gradually from bottom up 

to top or from left to right. After finding the starting point, a contour line is 

allowed to move in the region so as to judge whether it crosses the side of grids or 
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not. Suppose that the coordinate of the intersection point of the contour line and a 
\ 

certain grid side is (£ , ri) while the intersection point of the contour line with the 

next grid side AB is (XO , YO). AB is called to be the entry side of the rectangular 

ABCD, Figure 3.3. Then to work out the side of the rectangle and the intersection 

point at which the contour line moves away. Obviously, the departure side of this 

mesh is spontaneously to be the entry side of the next mesh. 

There are two kinds of results in the whole-region searching method: 

a. No matter which point the contour line starts from, it will certainly 

return to the starting point. This demonstrates that the contour line is closed in the 

region. 

b. The starting point of the contour line is on the bounds of the region and 

finally the contour line can not move any more if it is on the bounds of the region 

again. 

c |D 

A 
Yd 
W/ B 

CI, v) 

/ 

/(x0 >  y o )  

/  I 

Figure 3.3 Moving contour line 
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No matter what kind of circumstances happens, it shows that the program 

has finished the search of one grade value. The search continues from one grade to 

another until all the grades are completed. Thus the figure of the contour lines is 

finished. 

2. The method of grid searching. 

The whole region searching involves generation of a very large array so as 

to store the temporary results. Furthermore, if the mesh is too large, the precision 

of the contour line can not be high. Grid searching method divides the mesh into 

smaller grids. In general, a unit is divided into 10 X 10 grids, Figure 3.4. 

As the contour line enters into the side of a grid, it will compare with all the 

values of inner nodes. The intersection nodes are then connected by straight lines. 

Compare with whole region searching, the precision of grid searching method is 

greater. However, the amount of calculations will be increased because every inner 

node needs to be compared. 

3. Improved grid searching method. 

This research makes use of double-linear interpolation to improve the grid 

searching. By this way, the precision of contour line can be ensured as well as a 

large amount of calculation time can be saved. The procedures of drawing up a 

contour line by the way of the improved grid searching method will be shown 

below: 
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Figure 3.4 Four nodes element 

(1) At first, the nodes and sides of the element are numbered, this is a 

crucial step in the grid searching method. For every contour line, it is necessary to 

remember that which side the contour line start from and where dose it end. If 

there are more than one contour line emerged in an element, the sequences of order 

should also be remembered. Such information can be used to draw up not only the 

contour lines but color contours as well. 
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(2) Search the entry side and intersection point of the contour line on the 

side of the element. 

(3) If the contour line enters into the horizontal lines, it will divide the 

element into several rectangles horizontally; and if the contour line enters into the 

vertical lines, it will divide the element into several rectangles vertically, Figure 

3.5. After that, it is necessary to search the interpolation points of the contour line 

by the way of linear interpolation on the rims of these rectangles. To link these 

points, a contour line whose value is equal to a certain level can be found. Then to 

increase or decrease the contour level, all the contour lines can be worked out. 

3.4 Color Contouring 

Compared with contour line, color contour possesses the advantage of 

expressing the distribution of various variables within the element more directly and 

clearly. To draw a color contour, the position of every contour line and routine it 

passes through are required to be solved at first. The detailed procedure is given 

below: 

1. Number the units and nodes 

The starting side, ending side, starting point and ending point of every 

contour line should be numbered, Figure 3.6. If there are more than one contour 

line which have the same level existing in an element, the contour lines are stored 

in sequence of the number of the starting side. Contour lines with different levels 

will be stored from small to big in the contouring value. 



Figure 3.5 Improved grid searching method 
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4 

1 

Figure 3.6 The regulation of numbering 

In the post-processor, the information concerned about the contour lines is 

stored in array K and SSJ, Figure 3.7. Suppose that the values of the contour lines 

are defined as 100, 200, 300, ... 1000, ten levels altogether. The points on the line 

indicate that how many intersection points have been found. The coordinates of 

these intersection points have already been stored in the arrays. The array K is 

divided in to 4 parts. The meaning of each part is defined as follows: 

Figure 3.7 Contour line samples 
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K[ 3 2 3 4 2 4 2 3 603 4] 

( A )  ( B )  ( C )  ( D )  

(A) Indicates how many different grade values there are in the unit, 

(B) Indicates grades, 

(C) Indicates the number of intersection points in each grade, and 

(D) Indicates the number of intersection points on each contour line 

(including starting and ending points). 

The matrix SSJ which is interrelated with matrix K shows as the following. 

4 1 0 0 " — for level 200 

2 3 4 1 -- for level 300 

1 2 0 0 — for level 400 

2. Constitute the array K 

Three parts, A, B, C in the array [K] are liable to be found. If there is only 

one pair of starting point and ending point, array K can be determined easily. 

When there are two pairs of starting and ending points, correspondingly, there will 

be two contour lines, Figure 3.8 

First to constitute an interpolation function, 

s=aO+al*X+a2*y+a3*x*y (3.1) 
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where a0=( sl+s2+s3+s4)/4 (3.2) 

al=(-s 1+s2+s3-s4)/4 

a2=(-s 1 -s2+s3+s4)/4 

a3=( sl-s2+s3-s4)/4 

xj xj+e 

xj+e 

y < - i  

Figure 3.8 To determine the contour line 

If there is an intersection point with the value of 100 and on the side 1 , 

Y1 =-1, it is very simple to get the solution of the value of XI, 

XI =(s0-a0-a2*yl)/(al+a3*yl) (3.3) 

So is the value of the contour line. Here it is given as 100. In order to 

choose which side will be the next one, only considering X=X1 + e (say s = 

0.01). From the eq(3.1), Y can be worked out. In case Y < -1, the next 

intersection point is on Side 4, or it is on Side 2. No matter whether the point on 
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Side 2 (X = 1) or on Side 4 (X = -1), the coordinate of the next inter-section point 

Y can be acquired. Thus, the starting and ending side of this contour line, and the 

starting and ending points will be fixed. At the same value, the next contour line is 

able to be determined with the same approach. 

It is convenient to search out the rest points on a contour line because the 

coordinates of the element are known. These points which have been searched out 

will be stored in the array X, Y, together with the starting point and ending point. 

3. Determine a closed region. 

In a rectangular element, a closed region that can be surrounded by one or 

two contour lines as well as with nodes. The coordinates of the points which 

surround the closed region are stored in the array XR and YR in the program 

POST2D. There maybe exist various kinds of situations in an element. Figure 3.9 

lists two of the possible situations. 

In figure 3.9, the first line indicates the information stored in array SSJ 

under this situation and the second line is the number of nodes. The searching 

processes described as follows: 

1) To start searching from array SSJ and remember the starting point. 

2) To transfer the coordinate of every point on the contour line from array 

X,Y to array XR,YR. 

3) To search on the second line for the node number which is equal to the 

ending point of the contour line, then compare the value of the node SN 

with the value of the contour line SL. 
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4) If SN > SL, then turn to (7) (Case b). 

130 

80 

start 
SSJ[ 1 => 2 

u 
3 4 1<= 2 

u 
end 

Case a 

0 0 ] 

3 4 12 3 

70 

130 

start 
SSJ [ 1 => 2 0 0 ] 

u 
3 4 1 2 => 3 => 4 =>1 2 3 

u 
end 

Case b 

Figure 3.9 Search case of closed area 

5) To add the coordinate of nodes to the arrays XR and YR, then turn to the 

left (-1) to search for the next node (Nodel). 

6) If the number of new node is equal to the number of starting node, then 

go to (8), otherwise go to (5). 

7) To go to the right (+1), get the solution of next node and store the 

coordinate in the arrays XR and YR until the number of the node is equal 

to the starting number. 
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8) Stop. 

The whole searching process is demonstrated with mark of arrows. If there 

are two contour lines, the searching program is showed as figure 3.10. 

130 

70 

80 

140 

start start 
SSJ [ 2 => 3 4 => 1 ] 

u u 
4 1 2 <= 3 4 <= 1 2 3 

u u 
end end 

160 

70 

start 

SSJ [ 2 => 3 4 => 1 ] 

U ft u 

4 1  2  3  =>4 1  =>2 3  

end 

Figure 3.10 Two contour lines for the first level 

If the closed region is surrounded by two adjacent contour lines and 

nodes, the situation will be much more complicated. Under that circumstances, the 

most important is to search the same number on the adjacent lines above all. Only 

if the same number can not be found on the line, turn to the line of the node 

number. Some examples are listed in Figure 3.11. 



r© „ 

end 
ft 
1 <= 2 0 0 

start' ft 
SSJ  1=> 2  0  0  

4 1 2 3 4 1 

end 
ft 

1 2 3 4=>l 
start ft 

SSJ 1 =» 2 3 => 4 
U ft 

4 1  2=»3 4  1  

end 
ft 

4 => 1 

ft 
ft 
ft 

4 1 

SSJ 

2 -

start ft 
1 =» 2 

4 1 

• 3 
it 
u 
u 
3 = 

SSJ 

end 

ft 
1 => 2 3 =» 4 

ft start ft U 
ft 2 =» 3 4 = 
ft ~=«=<=*=<=<=*=*= 

2 3 4 1 2 

Figure 3.11 More samples of search case of closed area 
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Chapter IV. The Control Program and Post Processor 

The flow of control of the program is rather straightforward and modular in 

structure. The program begins by setting up the screen with the menu display. The 

main menu controls the flow for duration of the program. Several main modules 

have been identified for this main command line: File, Edit, Windows, FEM, and 

Help. All but PRE2D and POST2D are executed in this text window while the 

overlay module switches the program into graphics mode to display the graph. 

Each of these modules has specific selections and executable routines associated 

with each. These routines have been included in the flow charts for each of the 

modules. Menu choices shall rise in the pull-down and dialogue menu structure. 

The FEM2D hierarchy and modules are shown in Figure 4.1. 

4.1 Menu System and User Interface 

The menu system is the framework of an event-driven, windowing 

application. The menu system consists of three parts, the menu bar, desktop, and 

status line. The menu system is shown in Figure 4.2. The desktop is the shaded 

background against which the rest of the application appears and covers nearly all 

of the screen. The bar menu is at the top of the screen, and the status line is on the 

bottom. Words in the menu bar represent menus, which are 'pulled down' by 

clicking on the words with the mouse pointer or by pressing hot keys. The text that 

appears in the status line shows available hot keys, or prompts for commands that 

are currently available to the user. 
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Post-Processor 

Help j-
Index 

Help on help 
Menu system 

Figure 4.1 The FEM2D hierarchy and modules 



37 

lliisiliapii ihlfipiilin 

The Kiln Frogru of 
Static and Dyuiiic Finite Elenent Ant lysis 

uith Preprocessor tnl Postprocessor 

•eueloped wj: Bafnlan Tao 1 Ir. C.S. Besal 

Department of Civil Eng. and Eng. Mechanics 
University of Ar 

iilirapiki'li!!!;!!:!!!! î raipwikhr 
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Figure 4.2 The Menu display 

After the program is loaded into memory, the menu system will do a 

number of things, including: 

* Clearing the desktop 

* Prepare screen in text mode (80x25 characters). 

* Display a menu bar and a status line. 

* Establishing a handler for keystrokes and mouse events 

* Wait for user to take some action, through the mouse or keyboard 
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4.2 Pull-Down Menus 

The menu system and user interface are completely interactive and menu-

driven. The program can be driven either by mouse or keyboard. There are 

actually three ways to select the menu items: 

* Move the mouse pointer over the item and click the mouse button. 

* Press F10 to take the cursor to the menu bar, then move the cursor to 

the appropriate item and press Enter 

* Press Alt-'CH', where 'CH1 is the highlighted character in the menu 

command. 

In all three cases, a pull-down menu appears below the item selected. Then 

the immediate lower level or sub-menu then shows up. If the item happens to be 

the lowest level in the root, the program will take appropriate action and will call 

the appropriate subroutine(s). 

The user can select a menu item either from the keyboard or with the 

mouse. The arrow keys move the highlight bar up and down the menu. Selecting a 

highlighted item from the keyboard is done by pressing ENTER when the desired 

item is under the highlight bar. Selection by the mouse is generally quicker. After 

clicking on a menu bar item, the appropriate sub-menu appears. The highlight bar 

follows the movement of the mouse up and down on the possible selections. When 
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a desired item is reached, the user clicks the left mouse button. The right button 

will be inactive during the program's execution. 

4.3 Main Modules of Master Control Program 

File 

The File menu lets user open and create files in the windows. The menu 

also lets user save changes, perform other file functions, shell to DOS, and 

quit. 

Open— The File | Open command displays a file-selection dialog box for 

user to select a input file which has the extension .PST. 

New— The File | New command opens a new Edit window. The new file is 

used as a temporary edit buffer. The program prompts user to name 

a new file, when user saves it. 

Save— The File | Save command saves the file in the active window to the 

hard disk drive. 

Save As— The File | Save As command saves the file in the active Edit 

window under a differing name, in a differing directory , or on a 

different drive. 
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Change Dir— The File | Change Dir command specifies a drive and 

directory to make it current. 

DOS Shell— The File | DOS Shell command lets user temporarily exit 

FEM2D program to enter a DOS command or program. 

Exit— The File | Exit command exits FEM2D, removes it from memory, 

and returns user to the DOS command line. 

Edit 

The Edit menu lets user cut, copy, and paste text in the windows. The user 

can also open a Clipboard window to view or edit its contents. 

Undo- The Edit | Undo command reverts the effect of the most recent 

action if that action is reversible. 

Cut- The Edit | Cut command removes the selection from the document 

and places it on the Clipboard. 

Copy- The Edit | Copy command copies the selection onto the Clipboard. 

Paste- The Edit | Paste command Copies the contents of the Clipboard to 

the document at the insertion point. 
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Show Clipboard— The Edit | Show Clipboard opens the CLIPBOARD 

window and shows the contents. 

Clear— The Edit | Clear command removes the selected text but does not 

put it into the Clipboard. 

Windows 

The Window menu contains window management commands. 

Size/Move— Choose Window | Size/Move option let user change the size 

or position of the active window. 

Zoom- Choose Window | Zoom option let user resize the active window to 

the maximum size. If the window is already zoomed to the maximum, the 

user can choose this command again to restore it to its precious size. 

Tile— Choose Window | Tile option let user view equally all opened Edit 

windows. Tiling makes all user open Edit windows a similar size and lays 

them out in next to the other so none overlay. 

Cascade— Choose Window | Cascade option let user stack all open Edit 

windows. Cascade only lets user fully view the active window; only file 

names and window numbers are visible for the other windows. 
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Next— Choose Window | Next option let user make the next window active, 

which makes in the topmost open window. 

Previous— Choose Window | Previous option let user make the previous 

window active (the window last opened before the currently active one). 

Close Choose Window | Close option let user close the active window. 

Help 

On-line context-sensitive help will be only a keystroke( or a mouse click) 

away. The user will get help at any point (except when the program 

is working in the graphic mode) by pressing the shortcut Fl. The 

Help menu will provides user with a detail index, searching 

capabilities, the ability to go back to other screens, and help on help. 

Any help screen will contain one or more keywords (highlighted 

items) on which one can get more information. 

Quit 

A pop up window will confirm selection to end the program. 

4.4 Main Modules of POST2D Program 

The POST2D hierarchy and modules are shown in Figure 4.3. 
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File 

The File menu lets user open and read a data file. 

From File — The File | From File command displays a message on the 

dialog window, user needs to give the data file name without any extension. 

The POST2D reads the date from a file previously created by finite element 

program for the purpose of displaying the results. 

To File — The File | To File command allows the user to save a file. The 

program prompts user to name a new file when user saves it. 

Select 

The Select menu contains commands that let user change various default 

settings in POST2D. Most of the commands in this menu take user either 

down to a sub menu or to a dialog window. The user can save the settings 

so they are in effect the next time.• , 

Switch — The Select | Switch command lets user select following options: 



44 

k From File 

To Flie 

-» Graph Type 

Select } 

Switch 

Node ON/OFF 
Eletn ON/OFF 

\ r Mat ON/OFF 

J B.C. ON/OFF 
d I.C. ON/OFF 

Shoui Rll ON/OFF 

FEMType 

—m Display I 

Ouerlay 

Display 

Zoom 

Plot 

Mesh Plots 
Uector arrow plots 
Color Contour Plots 
Contour Line Plots 

Original 
Deformed 

Stress 
Strain 

static 
Dunamic 

H-Stress 
V-Stress 
Sigma t 
Slgma2 

x-Strain 
V-straln 
EpcilonI 
Epcilon2 

| Zoomin 
Zoomout 

ll r ZoomFactor 
i r Pan 
M  Reset 

Tanslation 

EHit 

Figure 4.3 The POST2D hierarchy & modules flow chart 
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Node numbering (ON/OFF) 

Element numbering(ON/OFF) 

Material types (ON/OFF) 

Boundary condition (ON/OFF) 

Initial condition (ON/OFF) 

Show all options (ON/OFF) 

Graph Type — The Select | Graph Type command pups out a sub menu 

that lists several options, Mash Plots, Vector Arrow Plots, Color Contour 

Plots, Contour Line Plots. The default setting is Mash Plots. 

FEM Type ~ The Select | FEM Type command displays a sub menu that 

displays several options: 

Original; 

Deformed; 

Stress; 

Strain. 

Original — The Select | FEM Type | Original command displays the 

original mash. 

Deformed — The Select | FEM Type | Deformed command displays 

either deformed mash or displacement arrow vector. 

Stress — The Select | FEM Type | Stress command displays arrow 

vector plot, colored or curved contouring for major principal stress or 
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minor principal stress. When the option is active, a sub menu will list 

several options: 

Stress at X direction; 

Stress at Y direction; 

Major Principal Stress aj; and 

Minor Principal Stress 03. 

X Stress — The Select | FEM Type | Stress | X Stress command 

displays the structure stress at X direction. 

Y Stress — The Select | FEM Type | Stress | Y Stress command 

displays the structure stress at Y direction. 

Sigma 1 — The Select | FEM Type | Stress | Sigma 1 command 

displays the major principal stress ctj. 

Sigma 2 — The Select | FEM Type | Stress | Sigma 2 command 

displays the Minor Principal Stress CT3. 

Strain — The Select | FEM Type | Strain command displays arrow 

vector plot, colored or curved contouring for major principal strain or 

minor principal strain. When the option is active, a sub menu will list 

several options: 

Strain at X direction; 

Strain at Y direction; 

Major Principal Strain ej; and 

Minor Principal Strain 83. 
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X Strain — The Select | FEM Type | Strain | X Strain command 

displays the structure strain at X direction. 

Y Strain — The Select | FEM Type | Strain | X Strain command 

displays the structure strain at Y direction. 

Epsilon 1 — The Select | FEM Type | Strain | Epsilon 1 command 

disp lays  the  major  pr inc ipa l  s t ra in  e j .  

Epsilon 2 — The Select | FEM Type | Strain | Epsilon 2 command 

displays the Minor Principal Strain 83. 

Time Step — The Select | Time Step command lets user select the time 

step on the dynamic analysis. 

Display — The Select | Display command redraws the graphic by using 

the current settings. 

Overlay 

The command displays a sub menu let user to display and zoom the 

graphics. 

Display— The Overlay | Display command lets user make a plot of the 

Graph with current setting. 

Zoom— The Overlay | Zoom command lets user resize, move, set, and 

redefine the graphics. Zoom menu contains the commands are as follows: 

Zoom in; 
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Zoom out; 

Zoom Factor; 

Pan; 

Reset; 

Redefine. 

Zoom in ~ The Overlay | Zoom In command enlarges the graphics. 

Zoom out — The Overlay | Zoom Out command shrinks the graphics 

and brings back the immediate previous zoom window. This can be 

done up to the Original window. 

Zoom factor — The Overlay | Zoom Factor command lets user zoom the 

entire graphics window by using a factor. A value greater than 1 will 

enlarge and less than 1 will compress the figure. 

Pan — The Overlay | Pan command lets user translated the graphics by 

using the distance and direction supplied by the user. 

Reset — The Overlay | Reset command sets current graphics window co

ordinates to the original window co-ordinates. 

Redefine — The Overlay | Redefine command redefines the current 

window co-ordinates as the Original window co-ordinates. 

Plot- The Overlay | Plot can also produce drawings on pointer plotters, like 

dot matrix and laser printers. 
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Exit 

Prompts the user to check whether he or she wants to quit. If user responds 

'Y1, it will then prompt whether he wants to save the recent version of data 

before quitting. 
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Chapter V. Application to Practical Problems 

5.1 General 

In this research, a hypothetical concrete dam on a rock foundation is 

analyzed by comparing both linear and nonlinear material behaviors. Both static and 

dynamic (earthquake) analyses are performed. The finite element analysis program 

used to solve these practical problems is SST DYN[3]. 

The cross-section of the dam is shown as Fig. 5.1. The foundation level is 

at 30.5m and crest level is at 68.59m. The maximum water level is at 65.9m. The 

drainage gallery, 2.5m X 3.5m, is provided just below the rock level, as shown in 

the figure. 

For the linear and nonlinear analyses, the material properties of the dam 

and foundation are as follows: 

1. Foundation (Rock) material: 

Young's modules E = 80000kN/m2 

Poison's ratio u  =0 .3  

y = 18 kN/rn^ 

<f> = 30 

Unit Weight 

Angle of internal friction 

Cohesion c = 0 kN/m2 
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2. Dam (Concrete) material: 

Young's modules 

Poison's ratio 

Unit Weight 

E = 150000kN/m2 

u =0.3  

Y = 22.56 kN/m^ 

3. Nonlinear (Sandstone) material: 

The constants for ultimate yielding: 

Y 0.18 

p 0.80 

m -0.5 

n 7.00 

t|i 0.40 

ax 2.5 X 10 -10 

Tension Cut off 0.21 

These material properties were obtained through comphensive loberatory 

testing of concrete and roke materials[ll]. The linear behavior is simulated as 

elasic, while for the nonlinear behabior 

5.2 Linear Static Analysis 

In this research, two static load cases are considered. 

- The self weight. 

- The self weight and water pressure. 
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Figure 5.1 and figure 5.2 show the finite element mesh for the dam and 

foundation. Figure 5.3 and figure 5.4 show the deformed of the system vectors of 

displacements respectively, and figure 5.5 and figure 5.6 show contour of principal 

stresses cq and principal strain respectively, under the self weight. Figure 5.7 

to figure 5.10 show corresponding results for self weight plus water pressure. The 

maximum compressive (positive) stresses are 870KN/m2 and 720KN/m2 

respectively for the two cases. 

5.3 Linear Dynamic Analysis 

In dynamic analysis, the El Centra 1940 earthquake record[2] is used. Here 

the displacements are applied at the base of the foundation. Figure 5.11 shows the 

relationship between the earthquake acceleration and displacement. Figure 5.12 to 

5.21 display the deformation of the dam under the action of the earthquake force at 

the time interval [0.0,3.0] second by a time step of 0.3 second. 

Figure 5.22 to Figure 5.25 demonstrate the time histories of the 

displacements and stresses at nodes A, B, C, D respectively. 
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5.4 Nonlinear Dynamic Analysis 

The nonlinear analysis is performed using the Hierarchical Single Surface 

(HISS) plasticity (80) model with elastic unloading and reloadingfl 1]; the material 

constants have been stated previously. 

Figure 5.26 to figure 5.35 show the deformed structural configuration during 

the interval of 0.3 second to 3 second with time step of 0.3 second for the non-linear 

behavior of the material. 

Figure 5.36 to figure 5.39 display the transient displacements and transient 

stresses at nodes A, B, C, D. 

Figure 5.40 shows the comparison of displacements under both of linear and 

nonlinear material behaviors on node E. Figure 5.41 compares the histories of stresses 

while figure 5.42 compares histories of strains respectively at node E under both of 

linear and nonlinear situations. 

Figure 5.43 to figure 5.45 show the comparison of displacement, stress, and 

strain at node F under both of linear and nonlinear cases. 

Compared with dynamic analytical results of linear and non-linear patterns, it 

can be seen that the peak values in linear status are lower than those in non-linear 

status. 
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Allowable compression stress and allowable extension stress are 5077 psi and -

398 psi respectively[ll]. Figures 5.46 to 5.49 show that the maximum compression 

stresses (aj) and maximum tensile stresses (03) from both linear and nonlinear 

analyses are less than the allowable stresses. The dam and foundation are safe under 

the dynamic loading. 
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FIGURE 5.17, Deformation at time 1.8 second (Linear Dynamic Analysis) 
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FIGURE 5.26, Deformation at time 0.3 second (Non-Linear Dynamic Analysis) 
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FIGURE 5.28, Deformation at time 0.9 second (Non-Linear Dynamic Analysis) 
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FIGURE 5.29, Deformation at time 1.2 second (Non-Linear Dynamic Analysis) 
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FIGURE 5.30, Deformation at time 1.5 second (Non-Linear Dynamic Analysis) 
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FIGURE 5.31, Deformation at time 1.8 second (Non-Linear Dynamic Analysis) 
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FIGURE 5.34, Deformation at time 2.7 second (Non-Linear Dynamic Analysis) 
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FIGURE 5.35, Deformation at time 3.0 second (Non-Linear Dynamic Analysis) 
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FIGURE 5.36, Time histories at point A (Non-Linear Dynamic Analysis) 
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FIGURE 5.39, Time histories at point D (Non-Linear Dynamic Analysis) 
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FIGURE 5.42, The comparison of strain on node E 



The time histories of deformation 

1.50E-01 T 

X - Displacement (Non-Linear) 5.00E-02 -• 

Y - Displacement (Non-Linear) 

X - Displacement (Linear) 

Y - Displacement (Linear) 

-1.50E-01 1 

Time (second) 

FIGURE 5.43, The comparison of displacements on node F 
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Summary 

This project develops two programs. 

1. FEM2D is the control program of software package for the 2D static and 

dynamic finite element analysis. This program is compiled by applying the most 

advanced technology on program design — Object Oriented Programming which 

includes Interactive, Menu-Driven, Multi-windows, On-line Help. The program 

FEM2D connects pre-processor[6] and post-processor with the finite element 

analysis program SST DYN[3]. 

2. POST2D is the general purpose post-processor for finite element analysis. 

The program makes use of the technology of Interactive, Menu-Driven and On-line 

Help. 

The capabilities of FEM2D and POST2D are listed as follows: 

(1) The FEM2D and POST2D are mouse supper and menu driven 

interactive programs. They are easy-to-leam and easy-to-use. 

(2) The POST2D is able to graphically present analytical results from finite 

element program SST DYN[3] or any other FEM program. 

(3) The POST2D is able to display the results of static analysis or dynamic 

analysis in the form of engineering graphics. 
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(4) The POST2D program is capable of displaying the 3, 6 nodes triangle 

element and 4, 8 nodes quadrilateral element. It will be able support 

any finite element after a little modification. 

(5) In the program, four kinds of forms, Mesh, Vector arrow or Color 

Contour and Contour Line can be chosen to display original mesh, 

displacement, stress and strain. 

(6) There are Zoom functions in the program and can be chosen freely, 

enlarged and shrunk to display the results. 

(7) Interactive and On-line Help can be used to help users to be familiar and 

master the usage method of both of FEM2D and POST2D. 

Static and dynamic linear as well as non-linear analyses of a concrete dam 

on rock foundation are performed using the SST DYN finite element program. 

Results from the use of the POST2D program are used to analyze stresses and 

deformations under static and dynamic (earthquake) loading, including comparison 

of results from linear and nonlinear constitutive research. 
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Appendix A. User's Guide 

A.l How to use this manual 

The FEM2D's documents include four manuals for different purposes. 

* To run the FEM2D, read this guide and Appendix B. 

* To run the pre processor PRE2D, read PRE2D manual[6]. 

* To run the finite element program SST DYN, read SST DYN manual[3]. 

* To run the post processor POST2D, read this chapter and appendix C, 

The user's manual for POST2D. 

A. 2 Getting Started 

What does the user need: 

* IBM PC or PC compatible Computer 

* 80286 or higher processor 

* 640K or higher memory 

* VGA Color monitor 

* Mouse 

* FEM2D program FEM2D.exe 

* PRE2D software package (Including PRE2D.EXE, PREMENU.DAT, 

PREMENU.HLP, EGAVGA.BGI) 

* Finite element analysis program SSTDYN.exe 

* POST2D software package (Including POST2D.EXE, POSTMENU.DAT, 

POSTMENU.HLP, EGAVGA.BGI) 

* Printer is optional 
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Symbols and conventions 

The manual uses a few special symbols and conventions. 

The Keyboard 

* The key on user's keyboard may not be labeled exactly as they are in this 

manual. For example, the Control key is shown as CTRL; the 

Escape key is shown as ESC. 

* Keys are frequently used in combinations or sequences. For example, 

CTRL+K means to hold down the CTRL key while pressing K key, 

and CTRL+K K means to press and release these keys in order: first 

CTRL+K, and then K. 

* Arrow keys in the collective name for UP ARROW, DOWN ARROW, 

LEFT ARROW, AND RIGHT ARROW keys. 

* To choose a command from a menu, you can use the mouse or press a 

key combination. In procedures, key sequences follow the menu and 

command names. For example, from the FEM2D menu, choose 

Quit(ALT, X). 

What does the user need to know 

After PRE2D or POST2D program has been loaded into the RAM, the 

'MAIN MENU' will be displayed. Now the program can be driven either by 

mouse or keyboard. 

With a mouse: 
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* The user can select the menu item by pointing the mouse and clicking the 

LEFT BUTTON. This brings the immediate lower level sub menu. In 

case, the item happens to be the lowest level in the root, the program will 

take appropriate action; Ex. If the option is 'Contour Line,' then the 

program draws the contour line on the screen. 

* The user can use the RIGHT BUTTON on the mouse to abort the 

operation and get back to the menu item. If the current menu happens to 

be the MAIN MENU, the program will prompt the user to check whether 

he wants to exit the program. The RIGHT BUTTON on the mouse is 

also useful to return ftom graphical window to menu. 

From the keyboard: 

* The user can simply use the cursor keys to highlight the desired item and 

the pressing ENTER, (ENTER, hereafter referred as <CR> ). Note that 

left arrow key takes to the immediate parent menu and right arrow is 

equivalent of pressing the <CR> on the highlighted menu item. Once 

the user gets used to these, he will find that it is a very fast way of 

selecting the menu item or switching from the menus. 

* Escape key (hereafter referred as <ESC>) is key board equivalent of the 

right button on the mouse. In addition, if desired, the user can also use 

the < ESC > to abort any keyboard operation. 
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* The following three special functions are applicable for the cursor 

managed by the mouse. 

'V' (Vertical) : Restricts the cursor to move only in the vertical 

direction until either 'H' or 'R' is pressed. 

'H' (Horizontal): Restricts the cursor to move only in the horizontal 

direction until either 'V' or 'R' is pressed. 

'R' (Reset): Allows the cursor to move in both directions. 

A.3 Starting the program: 

1) Turn on the computer. 

2) Change default drive or directory to where the program is installed. 

3) Type in FEM2D. 

4) If user wants to run the pre or post processor directly, type the PRE2D 

or POST2D respectively. 

5) The screen will display the initial logo window. To continue, press 

< ENTER > or click the left button of the mouse. 

Starting the POST2D program 

Starting either from FEM2D or beginning from POST2D directly, the 

program will show the root menu and logo window. 

Any operation must start from File Menu. After select the File, the File sub 

menu will be popped out, and then select the option From File. 
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Once the option From File is selected, a message will show up, user needs 

to give the data file name without any extension. For example, if the input data file 

name is BAR.PST, the user only needs to type 'BAR,' the default extension name 

always be 'PST'. The POST2D reads the date from a file previously created by 

finite element program and draws the original mash of the structure to be analyzed. 

A.4 Selecting the graphic type and display mode 

The user can choose various graphic types and display mode by selecting 

Select sub menu. The items of the sub menu are as follows: 

Switch; 

Graph Type; 

FEM Type; 

Time Step; 

Display 

To switch the setting 

Just simply click the mouse or highlight the item, the user can turn on or off 

the following settings: 

Node numbering (ON/OFF) - to show the mesh with or without node 

number, 

Element numbering(ON/OFF) - to show the mesh with or without element 

number, 

Material types (ON/OFF) - to show the mesh with or without material type, 

and 

Show All options (ON/OFF) - to turn on or turn off all the switches. 
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The default settings are off. 

The user can select the graphic type on the Graph Type sub menu which 

contains several options, Mash Plots, Vector Arrow Plots, Color Contour Plots, 

Contour Line Plots. The default setting is Mash Plots. 

The user can select the display mode on the FEM Type sub menu which 

includes following options: 

Original, 

Deformed, 

Stress, and 

Strain. 

If the Original option is selected, the program displays the original mash. 

If the Deformed option is selected, the either deformed mash or displacement arrow 

vector will be displayed base upon the setting of the Graphic Type. 

For the displays of the Stress and the strains, the user can choose an option 

to show the X direction value, Y direction value, major principal value, and minor 

principal value. 

The user can select the Time step to present the results from the dynamic 

analysis. 
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A.5 Display the graphics 

Display and Redraw 

The graphics will be shown on the screen immediately, after select either the 

Display option on the Select sub menu or the Redraw option on the Overlay sub 

menu. 

When the user selects the option from the FEM Type sub menu, the 

graphics will display at once. 

To move or resize the graphics 

There are several items in the Overlay | Zoom sub menu: 

Zoom in, 

Zoom out, 

Zoom Factor, 

Pan, 

Reset, and 

Redefine. 

The user can enlarge any part of the graphics by selecting the option Zoom 

in. First the user needs to point to one of the two diagonal points of a rectangular 

regain, and then hold down the left mouse button and drag the mouse pointer to 

another diagonal point. The Zoom out option will bring back the immediate 

previous zoom window. This can be done until the Original window is obtained. 
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The Zoom factor option lets user zoom the entire graphics window by using a 

factor about the center of the current window. A value greater than 1 will enlarge 

and less than 1 will compress the figure. 

The Pan option lets user translate the whole figure with same scaling. The 

user needs to point the two points of a vector by the mouse, and whole figure can 

be translated by the amount and direction of the vector. 

The user can set current graphics window co-ordinates to the original 

window co-ordinates or Zooms out sufficient number times to get back to the 

original window by using Reset option. Also the user can redefine the current 

window co-ordinates as the Original window co-ordinates by selecting the redefine 

option. 

A.6 Exit 

The Exit command terminates the POST2D program, and return control to 

master control program FEM2D. 
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Appendix B. The FEM2D User's Manual 

File 

The File menu contains functions for opening and saving files. In addition, it 

lets the user to change the current directory, print a file, exit to DOS 

temporarily, or exit from the FEM2D program. 

Open— The File | Open 

The Open lets the user select a file from a list. The FEM2D displays 

a file-selection dialog box for user to select an input which has the 

extension .PST. 

Any of following actions are possible toward opening a file; 

1. Type in a full file name, then choice either Replace or Open. 

2. Type in a file name with wild cards, then one can select a file 

from a filtered list. 

3. Press down-arrow key to choose a file from a file list. 

4. Check the contents of different directories by selecting a directory 

name in the file list. 

If you enter a file name that does not exist, FED2D will 

automatically create and open new file with that name. 

New— The File | New 

To select the New option from the File menu, the FEM2D opens a 

new empty text window with a default file. The new file is used as a 



115 

temporary edit buffer. The program prompts user to name a new file 

when the user saves it. 

Save- The File | Save 

The Save option saves the file in the active Edit window to a hard 

disk or a floppy disk. If the file is a new one, FEM2D asks the user 

to enter a new name for the file, and saves it in a directory or in a 

driver. 

Save As- The File | Save As 

The Save As option saves the contents of the active Edit window to 

disk, but first asks the user to enter a filename. The name can be a 

new filename or the name of an existing file. If the user enters the 

new file name, optionally with drive and directory, and clicks or 

chooses OK, the file is updated with the new name. If the user picks 

an existing file name, that file will be overwritten. 

Change Dir~ The File | Change Dir 

The Change Dir option specifies a drive and directory to make 

current. The current directory is the one FEM2D uses to save files 

and to retrieve files. 

The user can change directory by entering the desired path or by 

selecting directory from the directory tree displayed in the dialog 

box. 
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If the user wants to go back to the previous directory, choose the 

Revert button on the Change Directory Window cam be chosen. 

DOS Shell— The File | DOS Shell 

Selecting the command of DOS Shell temporarily exits FEM2D 

program and brings the user to the DOS prompt where the use can 

use DOS commands and run other programs. To return to FEM2D, 

type EXIT and press ENTER key. 

Exit— The File | Exit 

The Exit option terminates the FEM2D, removes it from memory, 

and returns control to DOS. If any changes have been made and are 

not saved, FEM2D will ask the user to save them before exiting. 

Edit 

The Edit function of FEM2D enables the user to have multiple source files open 

in different windows at the same time. The Edit menu lets user cut, copy, and 

paste text in Edit windows via the clipboard, and a special buffer sets up to hold 

the text that one wants to move. The user can also open a Clipboard window to 

view or edit its contents. 

The most editor actions apply to select text. The user can select text either by 

using keyboard or mouse. 
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From the keyboard the user can use any of the following methods: 

1. Press and hold on Shift key while pressing any arrow key. 

2. Press Ctrl-K B to mark the start of the block. Then move the cursor to 

the end of the text and press Ctrl-K K. 

3. To select a single word, move the cursor to the word and press Ctrl-K T. 

4. To select an entire line, move the cursor to the line and press Ctrl-K L. 

With a mouse: 

1. To select text with a mouse, drag the mouse pointer over the desired text. 

If user needs to continue the selection past a window's edge, just drag off the 

side and the window will automatically scroll. 

2. To select a entire line, double-click anywhere in the line. 

3. To select text line-by-line, click-drag over the text. 

4. To extend or reduce the selection, Shift-click anywhere in the document. 

Undo- The Edit | Undo 

The Undo option reverses the effect of the most recent action if that 

action is reversible. 

Cut— The Edit | Cut 

The Cut option removes the selected block of text from the active 

edit window and places it on the Clipboard. The user can then paste 

that text into any other document by choosing Paste. The text 

remains selected in the Clipboard so that the user can paste the same 
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text many times. Clipboard is a special window in FEM2D that 

holds text that the user has cut or copied. 

Copy— The Edit | Copy 

The Copy option copies the selection onto the Clipboard. It works as 

the Cut option except that it does not remove the selected block from 

the active edit window. The user can then paste that text into any 

other document by choosing Paste. The user can also copy text from 

a Help window. With the keyboard, use Shift and Arrow key; with 

the mouse, click and drag the text one wants to copy. 

Paste- The Edit | Paste 

The Paste option copies the text from the Clipboard into the active 

edit window, starting at the position of the cursor in the window. 

Before the text can be pasted into a window, it must first be copied 

or cut from an existing text file. The Paste option always uses the 

block of the text that was most recently added to the clipboard. 

Show Clipboard— The Edit | Show Clipboard 

The Show Clipboard option opens the CLIPBOARD window, which 

holds all text that has been cut and copied from other windows. The 

text that is currently selected is the text that gets pasted, and the user 

can edit the clipboard so that the chosen text is pasted precisely. 

Clear— The Edit | Clear 
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The Clear option removes the selected text from the active edit 

window, but does not put it into the Clipboard. The cleared text is 

not retrievable. The user can clear the Clipboard itself by selecting 

all the text in the Clipboard, then can select Edit | Clear. 

Search 

The Search menu lets user search for text, procedure declarations, and error 

locations in the user's files 

Find— The Search | Find 

The Search option lets the user locate a text pattern in a source file. It 

displays the Find dialog box, which lets one type in the text one wants to 

search for and set options that affect the search. Ctrl-Q F is another shortcut 

for this command. 

The Find dialog box contains several buttons and check boxes. 

Options 

The following are the options used to control a search 

Case sensitive Check this option if the user wants FEM2D to 

distinguish between lowercase and uppercase letters. 

Whole words only If this option is selected, FEM2D will match 

only those strings that is surrounded by blanks or punctuation marks. 
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Regular expression Checking this box enables FEM2D's extended 

expression matching, which provides for the use of the special 

characters. 

Scope The scope of the search can be either the entire file or limited 

to the currently selected portion of the text. 

Direction The search can proceed backward from the current cursor 

position or forward. 

Windows 

The Window menu contains window management commands. 

Size/Move— Choose Window | Size/Move to change the size or position of 

the active window. 

Zoom— Choose Window | Zoom option lets user resize the active window 

to the maximum size. If the window is already zoomed to the 

maximum, the user can choose this command again to restore it to its 

previous size. 



121 

Tile- Choose Window | Tile to view equally all user open Edit windows. 

Tiling makes the user open Edit windows a similar size and lays 

them out in next to the other so none overlay. 

Cascade— Choose Window | Cascade to stack all open Edit windows. 

Cascade only lets the user fully view the active window; only file 

names and window numbers are visible for the other windows. 

Next— Choose Window | Next to make the next window active. 

Previous— Choose Window | Previous to make the previous window active; 

the window last opened before the currently active one. 

Close Choose Window | Close to close the active window. 

Help 

On-line context-sensitive help will be only a keystroke( or a mouse click) 

away. The user will get help at any point (except when the program 

is working in the graphic mode) by pressing the shortcut Fl. The 

Help menu will provides the user with a detailed index, searching 

capabilities, the ability to go back to other screens, and help on help. 

Any help screen will contain one or more keywords (highlighted 

items) on which one can get more information. 



Quit 

A pop up window will confirm selection to end the program. 
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Appendix C. The P0ST2D User's Manual 

The MAIN Menu has the following options: 

File, 

Select, 

Overlay, and 

Exit. 

File 

Any operation must start from File Menu. The File menu lets user open and 

read a data file as well as save it. After select the File, the File sub menu 

will be popped out, and the items of the File are as follows: 

From File. 

From File — The File | From File 

Once the command From File is selected, a message will show up on 

the dialog window, user needs to give the data file name without any 

extension. For example, if the input data file name is BAR.PST, 

the user only needs to type 'BAR', the default extension name always 

be 'PST'. The POST2D reads the date from a file previously created 

by finite element program and displays the graphics on the screen. 

Normally the POST2D draws the original mash of the structure to be 

analyzed. 

Select 
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The user can change the default setting and display the graphics. When the 

Select menu is active, the Sub menu will be popped out. The items of the 

sub menu are as follows: 

Switch; 

Graph Type; 

FEM Type; 

Time Step; 

Display 

Switch — The Select | Switch command lets user select following options: 

Node numbering (ON/OFF), 

Element numbering(ON/OFF), 

Material types (ON/OFF), 

Boundary Condition (ON/OFF), 

Initial Condition (ON/OFF), and 

Show All options (ON/OFF). 

Graph Type — The Select | Graph Type command pups out a sub menu 

that lists several options, Mash Plots, Vector Arrow Plots, Color Contour 

Plots, Contour Line Plots. The default setting is Mash Plots. 

FEM Type — The Select | FEM Type command displays a sub menu that 

displays several options: 

Original, 

Deformed, 
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Stress, and 

Strain. 

Original — The Select | FEM Type | Original option displays the original 

mash. 

Deformed — The Select | FEM Type | Deformed option displays either 

deformed mash or displacement arrow vector. 

Stress -- The Select | FEM Type | Stress command displays arrow vector 

plot, colored or curved contouring for major principle stress or minor 

principle stress. When the option is active, a sub menu will list several 

options: 

Stress at X direction, 

Stress at Y direction, 

Shear Stress, 

Major Principle Stress cq, and 

Minor Principle Stress 03. 

X Stress — The Select | FEM Type | Stress | X Stress option 

displays the structure stress at X direction. 

Y Stress — The Select | FEM Type | Stress | Y Stress option 

displays the structure stress at Y direction. 
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Shear Stress — The Select | FEM Type | Stress | Shear Stress 

option displays the shear stress. 

Sigma 1 — The Select | FEM Type | Stress | Sigma 1 option 

displays the major principle stress CT^. 

Sigma 3 — The Select | FEM Type | Stress | Sigma 3 option 

displays the Minor Principle Stress 03. 

Strain — The Select | FEM Type | Strain command displays arrow vector 

plot, colored or curved contouring for major principle strain or minor 

- principle strain. When the option is active, a sub menu will list several 

options: 

Strain at X direction, 

Strain at Y direction, 

Shear Strain, 

Major Principle Strain ej, and 

Minor Principle Strain S3. 

X Strain — The Select | FEM Type | Strain | X Strain option 

displays the strain at X direction. 

Y Strain — The Select | FEM Type | Strain | X Strain option 

displays the strain at Y direction. 
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Shear Strain — The Select | FEM Type | Strain | Shear Strain 

option displays the shear strain. 

Epsilon 1 — The Select | FEM Type | Strain | Epsilon 1 option 

displays the major principle strain e^. 

Epsilon 3 — The Select | FEM Type | Strain | Epsilon 3 option 

displays the Minor Principle Strain S3. 

Time Step — The Select | Time Step command lets user select the time 

step on the dynamic analysis. 

Display — The Select | Display command is used to clear the 

graphics window and redraw all the graphics using changed settings, if any. 

Overlay 

Redraw — The Overlay | Redraw command is used to clear the 

graphics window and redraw all the graphics using changed settings, if any. 

Zoom 

Zoom — The Overlay | Zoom command resizes and moves the 

graphics. When the command is selected, a sub menu will list 

several options: 

Zoom in, 
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Zoom out, 

Zoom Factor, 

Pan, 

Reset, and 

Redefine. 

Zoom in — The Overlay | Zoom | Zoom in option enlarges the 

graphics. Any part of the geometry in the current graphics window 

can be zoomed in by specifying the two diagonal points of a 

rectangular regain. Zoom in can be performed maximum ten levels. 

Note here that excessive zooming (approximately 300 times of the 

initial scale) will cause the program to crash. 

Zoom out — The Overlay | Zoom | Zoom out option brings back the 

immediate previous zoom window. This can be done until the 

Original window is obtained. 

Zoom factor — The Overlay | Zoom | Zoom factor option lets user 

zoom the entire graphics window by using a factor about the center 

of the current window. A value greater than 1 will enlarge and less 

than 1 will compress the figure. 

Pan — The Overlay | Zoom | Pan option lets user translate the 

whole figure with same scaling. The whole figure can be translated 
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by the amount and direction of the vector jointed by two points 

supplied by the user. 

Reset — The Overlay | Zoom | Reset option sets current graphics 

window co-ordinates to the original window co-ordinates or Zooms 

out sufficient number times to get back to the original window. 

Redefine — The Overlay | Zoom | Redefine option redefines the 

current window co-ordinates as the Original window co-ordinates. 

Exit 

The Exit command terminates the POST2D program, and return control to 

master control program FEM2D. 
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Appendix D. The format of Input Data File for POST2D and Example 

The Data Format 

The file name should have the extension .PST. All the data in the file is 

grouped in categories with an identifying name prefacing each group of data. Every 

identifying name must begin with > > and end with <. The order in which the 

categories appear below should be followed in the data file. All data is free format 

within each line. Any line beginning with an exclamation point (!) is a comment line 

and will be ignored by the POST2D. 

The post data file format and categories of data are as follows: 

> > TITLE < 

title Problem Description (up to 80 characters) 

> > GENERAL< 

origin, ndimen, ideal, thick, angle, nnodes, nelems, gflag 

origin program origin (for example, SST, DYN) 

ndimen number of dimensions (2D, 3D) 

ideal type of idealization (N/A) 

thick thickness in the z-direction 

angleangle in degrees from the gravity vector to the negative y-axis (positive in 

the CW direction, zero is the default angle) 

nnodes total number of nodes in mesh 

nelems total number of elements in mesh 
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gflag flag of position (one is on the gauss point, zero is on the node 

point) 

> > NODE COORD < (complete node list including nodes added later) 

> > ELEMENT DATA < (complete element list including elements 

added later) 

> > DEFINITION < (an ELEMENT LIST follows each DEFINITION 

given) 

eltype, nelnod, nelgp 

eltype element type (TRI, QUAD) 

nelnod number of nodes per element 

ndnum, xcoor, ycoor 

ndnum node number 

ycoor 

xcoor x-coordinate (or r for axisymmetric case) 

y-coordinate (or z for axisymmetric case) 

TRI = 3 or 6 

QUAD =4 or 8 

nelgpt number of Gauss points per element (4, 9) 

TRI = 4 

QUAD = 4, or 9 

>> ELEMENT LIST < 

elnum, matnum, connect 

elnum element number 

matnum number identifying material type 
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connect list of nodal numbers defining element (1... 

nelnod) 

TRI: CCW order 

QUAD: CCW order 

> > CONSTANT GEOMETRIC BOUNDARY CONDITIONS < (constant 

throughout solution) 

> > SOLID BODY DISPLACEMENTS < 

ndnum, idofx, idofy 

ndnum node number 

idofx degree of freedom of solid in x-direction 

(0=free, 1 = fixed) 

idofy degree of freedom of solid in y-direction 

(0=free, 1= fixed) 

> > CALCULATED OUTPUT DATA< 

> > SOLID DISPLACEMENTS < 

ndnum, xdisp, ydisp 

ndnum node number 

xdisp displacement in the x-direction (or r) 

ydisp displacement in the y-direction (or z) 

> > TOTAL STRESSES < 

elnum,xcoor,ycoor, sigx, sigy, sigxy, sigt 

elnum element number 

xcoor x-coordinate (or r for axisymmetric case) 

ycoor y-coordinate (or z for axisymmetric case) 

sigx normal stress in the x-direction (or r) 
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sigy normal stress in the y-direction (or z) 

sigxy shear stress in the xy-plane (rz-plane) 

sigt ring stress in theta direction (axisymmetric only) 

> > STRAINS < 

elnum,xcoor,ycoor,epsx,epsy,epsxy,epst 

elnum element number 

xcoor x-coordinate (or r for axisymmetric case) 

ycoor y-coordinate (or z for axisymmetric case) 

epsx normal stress in the x-direction (or r) 

epsy normal stress in the y-direction (or z) 

epsxy shear stress in the xy-plane (rz-plane) 

epst ring stress in theta direction (axisymmetric 

only) 

> >END< 

The Example 

> > TITLE < 

Insitu Stress Calc, gravity method, AXI-SYM; quad elem; mono load, Lin El 

>> GENERAL <: Thick Angle NNP NEL 

SST 2D AXISY 1.00000 0.0000 9 4 

! ROWAT PA NVERSN TOLER TOLERN TOLRMX 

NSTRS NSUBI 

0.000E+00 1.470E+01 2 1.00E-06 1.00E-04 0.00E+00 2 1 
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! 

! NMAT JCODEIELTYP E PR ROSOIL COER 

1 0 2 1.50000E+03 3.00000E-01 6.94000E-02 6.00000E-01 

>> NODE COORD <: X,R Y,Z 

1 5.0000000E+01 -5.0000000E+01 

2 0.0000000E+00 0.0000000E+00 

3 O.OOOOOOOE+OO -5.0000000E+01 

4 5.0000000E+01 0.0000000E+00 

5 1.0000000E+02 -5.0000000E+01 

6 1.0000000E+02 0.0000000E+00 

7 0.0000000E+00 -1.0000000E+02 

8 5.0000000E+01 -1.0000000E+02 

9 1.0000000E+02 -1.0000000E+02 

> > ELEMENT DATA< 

> DEFINITION <: NNP NGP PHASE 

QUAD 4 4 1 

> ELEMENT LIST <: ELNUM, MATNUM, CONNECTIVITY 

1 1 2  3  1 4  

2 14 15 6 

3  1 1 3  7  8  

4 15 18 9 

> > CONSTANT GEOMETRIC BOUNDARY CONDITIONS < 

SOLID BODY DISPLACEMENTS <: NDNUM, XDOF, YDOF, X, Y 

2 1 0 0.0 0.0 

3 1 0 0.0 0.0 
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5 1 0 0.0 0.0 

6 1 0 0.0 0.0 

7 1 1 0.0 0.0 

8 1 1 0.0 0.0 

9 1 1 0.0 0.0 

CALCULATED OUTPUT DATA< 

SOLID DISPLACEMENTS <: X,R Y,Z 

1 -1.5504300E-16 -2.4761905E+00 

2 0.0000000E+00 -4.9523810E+00 

3 0.0000000E+00 -2.4761905E+00 

4 1.8846144E-16 • •4.9523810E+00 

5 0.0000000E+00 -2.4761905E+00 

6 0.0000000E+00 -4.9523810E+00 

7 0.0000000E+00 0.0000000E+00 

8 0.0000000E+00 O.OOOOOOOE+OO 

9 0.0000000E+00 0.0000000E+00 

TOTAL STRESSES <: X,R Y,Z SIG X,R 

SIG THETA 

1 1.05662E+01 -1.05662E+01 4.32971E+01 

14 4.32971E+01 

1 1.05662E+01 -3.94338E+01 4.44992E+01 

15 4.44992E+01 

1 3.94338E+01 -1.05662E+01 4.32971E+01 

14 4.32971E+01 

SIG Y,Z SHEAR 

1.00733E+02 1.93024E-

1.02737E+02 4.74483E-

1.00733E+02 1.00405E-
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1 3.94338e+01 -3.94338e+01 4.44992e+01 1.02737e+02 1.48774e-

15 4.44992e+01 

2 6.05662e-1-01 -1.05662e+01 4.32971e+01 1.00733e+02 -4.25732e-

15 4.32971e+01 

2 6.05662e+01 -3.94338e+01 4.44992e+01 1.02737e+02 5.20437e-

15 4.44992e+01 

2 8.94338e+01 -1.05662e+01 4.32971e+01 1.00733e+02 -4.25732e-

15 4.32971e+01 

2 8.94338e+01 -3.94338e+01 4.44992e+01 1.02737e+02 5.20437e-

15 4.44992e+01 

3 3.94338e+01 -6.05662e+01 4.53791e+01 1.04203e+02 6.20615e-

15 4.53791e+01 

3 1.05662e+01 -6.05662e+01 4.53791e+01 1.04203e+02 6.20615e-

15 4.53791e+01 

3 3.94338e+01 -8.94338e+01 4.65812e+01 1.06207e+02 1.56473e-

15 4.65812e+01 

3 1.05662e+01 -8.94338e+01 4.65812e+01 1.06207e+02 1.56473e-

15 4.65812e+01 

4 8.94338e+01 -6.05662e+01 4.53791e+01 1.04203e+02 6.54706e-

15 4.53791e+01 

4 6.05662e+01 -6.05662e+01 4.53791e+01 1.04203e+02 7.57991e-

15 4.53791e+01 

4 8.94338e+01 -8.94338e+01 4.65812e+01 1.06207e+02 8.59883e-

16 4.65812e+01 
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4 6.05662E+01 -8.94338E+01 4.65812E+01 1.06207E+02 3.89434E-

15 4.65812E+01 

STRAINS <: X,R Y,Z EPS X,R EPS Y,Z SHEAR 

EPS THETA 

1 1.05662E+01 -1.05662E+01 -2.31741E-18 4.95238E-02 3.34575E-17 

-2.31741E-18 

1 1.05662E+01 -3.94338E+01 1.64904E-18 4.95238E-02 8.22437E-18 

1.64904E-18 

1 3.94338E+01 -1.05662E+01 -2.31741E-18 4.95238E-02 1.74035E-17 

-2.31741E-18 

1 3.94338E+01 -3.94338E+01 1.64904E-18 4.95238E-02 2.57876E-18 

1.64904E-18 

2 6.05662E+01 -1.05662E+01 2.31741E-18 4.95238E-02 -7.37935E-18 

-1.50883E-18 

2 6.05662E+01 -3.94338E+01 -1.64904E-18 4.95238E-02 9.02090E-18 

1.07366E-18 

2 8.94338E+01 -1.05662E+01 2.31741E-18 4.95238E-02 -7.37935E-18 

-2.73793E-19 

2 8.94338E+01 -3.94338E+01 -1.64904E-18 4.95238E-02 9.02090E-18 

1.94827E-19 

3 3.94338E+01 -6.05662E+01 2.44557E-18 4.95238E-02 1.07573E-17 

2.44557E-18 

3 1.05662E+01 -6.05662E+01 2.44557E-18 4.95238E-02 1.07573E-17 

2.44557E-18 
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3 3.94338E+01 

6.55289E-19 

3 1.05662E+01 

6.55289E-19 

4 8.94338E+01 

2.88935E-19 

4 6.05662E+01 

1.59227E-18 

4 8.94338E+01 

7.74198E-20 

4 6.05662E+01 

4.26649E-19 

end< 

•8.94338E+01 

-8.94338E+01 

•6.05662E+01 

•6.05662E+01 

•8.94338E+01 

8.94338E+01 

6.55289E-19 

6.55289E-19 

-2.44557E-18 

-2.44557E-18 

-6.55289E-19 

-6.55289E-19 

4.95238E-02 

4.95238E-02 

4.95238E-02 

4.95238E-02 

4.95238E-02 

4.95238E-02 

2.71220E-18 

2.71220E-18 

1.13482E-17 

1.31385E-17 

1.49046E-18 

6.75019E-18 
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